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Agenda

• What is CICS Dynamic Scripting

• Dynamic Scripting Feature Pack 1.0, 1.1

• Dynamic Scripting Feature Pack 2.0

• What’s new

• How it works

• How to use it

• Debugging

• Migration

4

Notes:

• This session will start off by discussing the need for CICS’s PHP support (called CICS Dynamic 
Scripting)

• We will touch on the previous releases of CICS Dynamic Scripting.  The Dynamic Scripting V1.0 and 
V1.1, which ran in CICS TS V4.1 and CICS TS V4.2, used Project Zero technology, which has been 
withdrawn by IBM

• We will talk about the CICS Dynamic Scripting Feature Pack (2.0) for CICS TS 5.1. 

• Installation

• Configuration

• Developing PHP applications

• Migrating your Project Zero applications

• Debugging your PHP application
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CICS Dynamic Scripting
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Number of applications

Time to value is more 
important than 
enduring value

Strategic, long-
lived applications

Enterprise 

Applications

Team/Project 

Applications Personal 

Applications

�Creating reports, dashboards and widgets

�Quickly front ending existing applications 

�Exposing CICS assets in mash-ups

�Creating productivity applications

�Quickly trying out new business ideas

� Introducing new IT staff to CICS via PHP

�Developing without a dedicated budget

�Porting existing unmanaged PHP into CICS

Departmental 

Applications

Can be used to develop and deploy lightweight, ‘fit for 
purpose’, situational applications that meet departmental, 
team, project and personal requirements, e.g.:

6

Notes:

• In our typical mainframe development, we normally only address mission-critical applications.  
Because these applications are normally high-volume and are very important to our business, we 
have surrounded them with procedures with tight controls that insure quality, consistency, availability 
and all of the other attributes needed for our main applications.  These applications are normally 
written in COBOL, PL/I, C, Assembler, or, Java running in CICS or in WebSphere Application Server. 
These provide industrial-strength environments for our applications.

• Besides these main applications, there are other applications our business needs for special 
situations, For example, we might want to quickly create a report or a dashboard that shows an 
application’s details.  These kinds of applications are commonly called ‘situational applications’. For 
most situational applications, time to value is more important than enduring value. In another words, 
the quicker the better.

• The demand for situational applications at some companies, has become more and more important, 
but due to the procedures and development techniques we use, it is sometimes hard for people have 
time to address them.

• CICS Dynamic Scripting is intended to address some of these shortcomings.  CICS Dynamic 
Scripting version V1.0 and V1.1, built on Project Zero technology, provides a productive environment 
that can be used to address situational applications.  CICS Dynamic Scripting is also a great way to 
introduce new IT staff to CICS via the PHP and Groovy dynamic scripting languages.   Now, for CICS 
TS V5.1, we have CICS Dynamic Scripting 2.0.
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CICS Dynamic Scripting FP 1.0 , 1.1

• Technology from Project Zero, WebSphere sMash v1.1.1.3 (projectzero.org)

• Project Zero has been removed

• Robust environment for situational reports, dashboards, and Web feeds

• Provides PHP and Groovy support in CICS – agile, productive environment

• Zero Resource Model (ZRM) with data managed by DB2 for z/OS

• Uses CICS TS V4.1 and CICS TS V4.2 JVMServer Technology

• Manageability, Scalability, and Security

• Situational applications - Quickly try business ideas

• Introduce new staff to CICS via PHP

• Run unmanaged PHP and WebSphere sMash applications in CICS

• Easily expose CICS assets with RESTful interfaces

• Feature Pack 1.0

• Optional no charge product extension to CICS TS V4.1 

• Feature Pack 1.1
• Optional no charge product extension to CICS TS V4.2

8

Notes:

• The most important functions in CICS Dynamic Scripting Fix Pack V1.0 and V1.1 are listed. 

• The feature pack is built based on technology called “Project Zero” which was an open source project.  
It provided a robust environment for situational applications like, reports, dashboards and so on. 

• You could exploit many of the features provided by the Project Zero technology to quickly and easily 
build custom services and applications around your CICS programs and data, for example, to expose 
CICS assets RESTfully, access DB2 for z/OS through the Zero Resource Model and so on.

• CICS Dynamic Scripting applications consist of scripts e.g. PHP or Groovy, that you write, and 
configuration files used by Project Zero on the zFS file system. They could be developed with the 
tooling of your choice. You could edit the files directly in zFS or use the CICS Explorer (or RDz) to 
edit files remotely.
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CICS Dynamic Scripting Feature Pack 2.0

• Each version of Dynamic Scripting is specific to a version of CICS. 
The Dynamic Scripting Feature Pack version 2 is developed for 
CICS Transaction Server for z/OS®, Version 5 Release 1 only; 
earlier releases are not supported

• You can use the feature pack to take advantage of the following web 
technologies: 

• A dynamic scripting CICS-based run time for PHP applications 

• Java as a programming language (you can switch between the 
two programming languages)

• The CICS Dynamic Scripting Feature Pack 2.0 is developed using 
the Liberty technology and the P8 (PHP Engine)

10

Notes:

• CICS TS 5.1 was GA December 2012. In this release, Java 7 is supported. Based on Java 7, IBM 
delivered CICS Dynamic Scripting Feature Pack 2.0 in 3Q 2013. CICS Dynamic Scripting Feature 
Pack V2.0 is for CICS TS 5.1 only. 

• In CICS Dynamic Scripting V2.0 Feature Pack, there is a big architectural change (from V1 and V1.1) 
and lots of new functions.  A CICS user runs the PHP in the Liberty Server.  The PHP Engine 
underneath is the P8 PHP Engine.  
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What is the Liberty Profile

• A lightweight, dynamic, composable ‘profile’ of 

WebSphere Application Server (WAS)

• Provides a sub-set of WAS capabilities to CICS

• Written entirely in Java

• Runs within an OSGi Framework, providing capabilities 
through groups of OSGi bundles known as 'Features'.

• Provides a Web Container and features (JSP and Servlets) 
– with more features to be added in later versions

12

Notes:

• The CICS Dynamic Scripting Feature Pack V2.0 runs in Liberty in CICS. 

• Liberty Profile is a lightweight, dynamic, composable ‘profile’ of WebSphere Application Server 
(WAS). The Liberty Profile in CICS provides a sub-set of WAS capabilities. For example, a user can 
run JSPs and Servlets in Liberty. Liberty is written entirely in Java.  It runs an OSGi framework within 
it.  All the capabilities are packaged as OSGi bundle called ‘features’.  For example, if a user wants to 
run a JSP in Liberty, they need to add the ‘JSP’ feature in the Liberty configuration file.  This is done 
by telling the Liberty Profile, in a configuration file, to add JSP support.

• CICS uses Liberty as a web container to run JSP and Servlets in CICS TS V5.1.  Liberty will add 
more features in later versions.
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Web 
App

CICS

Liberty

JVM server

CICS
Resources

Web 
Client

HttpRequest

HttpResponse

Liberty Profile In CICS

• Provides a ‘web’ container

• Provides OSGi framework

• Web Apps are developed and deployed using Eclipse IDE and 

CICS Explorer SDK
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Notes:

• The Liberty profile runs in CICS JVM server.  

• Web applications like servlets and JSPs run in the Liberty profile.  

• Liberty listens on its own sockets. The web application running in Liberty can use the JCICS API to 
access CICS assets and resources (like COBOL programs and TSQs).   Most of the CICS API is 
implemented in Java.

• The user’s web application are packaged as OSGi bundles and deployed into CICS.  You can use 
the Eclipse IDE and CICS explorer SDK to develop Liberty applications.
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• OSGi Bundles can be installed, started, stopped, updated, and 
uninstalled in a running system – they can go active once dependencies 
are resolved

• Can run multiple versions of the same module at the same time

• Can contain an ‘activator’ (a class invoked when the OSGi bundle is 
started)

• Can register themselves 
in the service registry

• Can declare, or discover, its 
dependencies

• Gives CICS installable, 
removable Java programs

• Provides CICS program 
isolation/protection

• Other capabilites

Installed

Resolved

Starting

Active

StoppingUninstalled

install

resolve
refresh
update start

uninstall

uninstall

stop

refresh
update

Policy: eager/lazy

OSGi Bundle States

OSGi Bundle Lifecycle
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Notes:

• OSGi is another layer for Java programs running in a JVM.  This ‘layer’ gives CICS Java capabilites
similar to other program languages running in CICS.

• Java programs are typically loaded from CLASSPATH (places where your Java program resides).  
Using regular Java capabilities, once a Java program is loaded, it cannot be unloaded (this means 
that there is no notion of a ‘newcopy’).  The OSGi framework gives removal/newcopy capability to a 
JVM (you can even run two different versions of the same program at the same time).

• An OSGi bundle also provides program protection: only the packages you specifically allow to be 
accessed can be accessed.  You must declare any package in another OSGi bundle that is usable by 
your program.

• This means that because we run your PHP program in an OSGI environment, you PHP program also 
receives these benefits.
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Structure of CICS Dynamic Scripting 2.0

JVM

CICS Transaction Server

HTTP 

Request

HTTP 

Response

Liberty Server CICS 

Assets

JCICS 

API

PHPServlet
PHPWrapper

PHP
P8 Engine 

Ext1 Ext2 Ext3 Extn

Web Container

DS FP V2.0 OSGI BundleApp1

App2

App3

App4

JVM
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Notes:

• CICS Dynamic Scripting 2.0 is packaged as a OSGi Bundle running in Liberty web container.  A JVM 
server runs in CICS and a Liberty profile runs in the JVM server to provide a web container. CICS 
Dynamic Scripting Feature Pack 2.0 runs in the web container.  

• When an HTTP request comes into Liberty, it will go into Dynamic Scripting Feature Pack V2.0.  The 
PHP request, will be interpreted and run by the P8 PHP engine.  

• Then, the response is send back to the client.  A PHP script running in Liberty can also access CICS 
assets like COBOL programs, TSQs and so on.

• There is a PHP to Java bridge, so CICS’s JCICS API for Java is accessible via PHP.
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The Benefits of running PHP in Liberty

• Can run multiple PHP applications in one JVM server 
which has multi-threaded capability

• Manage PHP applications in CICS bundles - CICS 
controls the whole life-cycle of the application

• Packaged as an OSGi EBA, so they are easily managed

• Mixed with other JEE technology, e.g. JSPs, servlets, so 
the user can embed PHP into JSPs

• Failures in one PHP application will not affect other PHP 
applications or other Java applications in the Liberty 
server

• The Liberty web container provides security, CICS 

threads, transactionality

20

Notes:

• In CICS Dynamic Scripting V2.0, we can deploy all PHP applications in one JVM server which has 
multi-threaded capability.  The user needs additional JVM servers only when the concurrent thread 
number will be larger than 256. 

• In CICS Dynamic Scripting V2.0, the lifecycle control of PHP application is simpler.  You can define a 
PHP application as a resource in CICS.  If the user wants to activate or stop a PHP application, they 
just enable or disable the resource in CICS.  CICS Dynamic Scripting Feature Pack 2.0 is much 
easier for the system program to control.

• All PHP applications are packaged as OSGi web bundles.  One or more of these web bundles are 
packaged in to an EBA bundle (Enterprise Bundle Archive).   A user then packages EBA bundles and 
related CICS resources into a CICS Bundle.

• From a CICS perspective, the systems programmer configures the JVM server and a CICS Bundle 
resources.  When the CICS bundle resource is installed into CICS, the CICS bundle becomes active.

• Another benefit is that users can mix PHP and Java, for example, a user can embed PHP into a JSP.

•

• EBA = Enterprise Bundle Archive

• WAB = web application bundle
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Installation and Pre-requirement

• CICS TS 5.1 with APAR PM80214 applied 

• Install Dynamic Scripting Feature Pack 2.0

• Use FTP to copy the Dynamic Scripting Feature Pack 2.0 
SMP/E installation package to a suitable directory in z/OS 
UNIX. You must have write access to this directory

• Use SMP/E to install Dynamic Scripting Feature Pack 2.0

• Setup the Dynamic Scripting Feature Pack 2.0 environment, 
such as an extension lib, set the Liberty bundle repository, etc.

• Development environment

• CICS Explorer V5.1.1.1 or higher

• PHP Development Tools (PDT) 2.1 or higher installed in 
Eclipse, if you want to debug PHP code (optional)

22

Notes:

• CICS Dynamic Scripting Feature Pack V2.0 is for CICS TS V5.1 only.  

• The user has to apply APAR PM80214 before they can use the feature pack.  This APAR is for the 
Liberty server.

• The installation of the CICS Dynamic Scripting Feature Pack V2.0 is managed by SMP/E.  It is a 
standard SMP/E installation process.  Download the install package, upload it to z/OS USS.  Install it 
using SMP/E.  The included Installation Guide details each step (see the CICS V5.2 InfoCenter).

• For a development environment, you can install the optional Eclipse plug-in called “PDT” in to 
Windows or Linux.  The PDT provides a PHP editor and a debug tool for PHP.  The PDT isn’t 
required to develop PHP scripts, but is quite helpful.
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Configure Eclipse for PHP Development: 
One-time per workspace

24

Notes:

• This section details the “one-time” workspace setup needed when developing OSGi-based PHP 
scripts for CICS using Eclipse.

• When you use Eclipse, you have the code that makes up Eclipse, and you have a separate 
workspace that holds your artifacts (your application code).  An Eclipse can point to one workspace 
at a time.  These steps have to be performed for each workspace you use to contain your PHP 
applications.
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Set up the CICS Explorer SDK – One Time…

• CICS Explorer 5.1.1.1 or higher

• One Time:

• Update target running platform –
Window->Preferences->Plug-in Development->Target Platform

• Then on the right – Click Add

• On the Target Definition dialog – Click the radio button next to 
“Template”, then in the pull-down next to Template, select 
“CICS TS V5.1 Runtime with PHP”, then “Finish”

• Back on the Target Platform page check CICS TS V5.1 Runtime 
with PHP”.  Then click “OK”.

• � The next slide, taken from the CICS Explorer, has the views and 
dialogs you will see when you do the above…

26

Notes:

• You need to configure the target runtime platform.  This makes available, all of the files needed to 
support PHP on CICS.

• After the CICS explorer SDK is installed, there is a target OSGi platform called ‘CICS TS 5.1 Runtime 
with PHP’ in the list. The com.ibm.cics.php Jar file is the core file of the CICS Dynamic Scripting 
Feature Pack V2.0.  

• If the OSGi target platform called ‘CICS TS V5.1 Runtime with PHP’ is not present, you likely have 
haven’t installed the proper maintenance on the CICS Explorer.  You must be at CICS Explorer 
V5.1.1.1 or higher. 
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Start CICS Explorer SDK – One Time

• Update target running platform

• Window->Preferences->Plug-in Development->
Target Platform->Add

This slide says 
the same as the 
last slide with 
pictures instead 
of words

28

Notes:

• Slide 25 says the same thing as slide 23.  Slide 25 shows the Eclipse dialogs you will see.

• Using the pull-down beside ‘Template’, you need to select ‘CICS TS V5.1 Runtime with PHP’ and 
click ok.

• Note that when you return to the ‘Target Platform’ dialog, the prior action just added the ‘CICS TS 
V5.1 Runtime with PHP’ to your choices.  You need to check the box next to ‘CICS TS V5.1 Runtime 
with PHP’ to activate it.
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PHP Development:
You may want to start with the supplied sample

30

Notes:

• This section talks about the PHP example provided with the CICS Explorer.  

• This will easily validate that CICS Dynamic Scripting is installed properly and you are ready to 
develop your own PHP applications.
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Start with the Sample

• The example PHP 
program is in the CICS 
Explorer SDK V5.1.1.1, 
and higher

• From the menu bar, 
File->New->Other, 
then Examples->CICS 
Examples->PHP->
CICS Dynamic 
Scripting Example 
(PHP)

32

Notes:

• This section talks about the PHP example provided with the CICS Explorer.  

• This will easily validate that CICS Dynamic Scripting is installed properly and you are ready to 
develop your own PHP applications.
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Create the PHP Sample

OSGi Bundle Project 
with web support 

contains the PHP code

OSGi EBA
Application project, 
contains the OSGi

Bundle project

CICS BUNDLE project, 
contains the EBA project

34

Notes:

• After installing the supplied example into your workspace, you will see three projects. 

• The third one (at the bottom) is the web application.  In this sample, there is only one JSP page.  This 
JSP contains PHP that accesses the Applid of the CICS region on which the script is running. 

• The first one at the top is an OSGi application project, also known as an EBA.  The EBA contains a 
reference to the PHP application (the OSGi bundle that describes the web application bundle 
mesions in the previous bullet).

• Second one down, is a CICS bundle project.  This CICS bundle project contains a pointer to the EBA 
project mentioned in the previous bullet.   The CICS bundle project will be installed into CICS.  We 
can use this bundle to manage the lifecycle of the PHP application.

• The projects are displayed in collating sequence.
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Relationship between projects and deployment

CICS resource EBA

CICS resource PROGRAM

CICS resource TRANSACTION

CICS resource xxxxx

Web application project 
contains PHP/JSP/..

OSGi bundle used by 
Web application project

OSGi bundle used by 
Web application project

CICS

Deploy

CICS Bundle

36

Notes:

• Note the relationship between these three projects and how to deploy the sample. For each PHP 
application, there will always be at least three projects.  You can have multiple EBA projects in the 
same CICS bundle.  You have multiple web bundles per EBA bundle.

• The EBA is an OSGi application bundle used to package web OSGi bundles.  The EBA includes the 
web application which contains PHP, JSP and so on.   It can also contain the other OSGi bundles 
which contain JAVA classes, and which will be used in the web application.  All of these can be 
packaged into an EBA.   

• The CICS bundle project will contain the EBA, and can optionally contain the CICS resources which 
are used to run the web application.  For example, if your PHP application LINKs to an existing 
COBOL program, or starts another transaction.  You can optionally define those resources in this 
CICS bundle.  After you deployment and install the bundle, all of the resources are created and 
installed into CICS at run time.

• The user can deploy the CICS bundle and all the resources it contains into z/OS. The CICS Explorer 
is used to create all of the resources in the CICS bundle.
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PHP Supplied Sample Code

• Example PHP code in the provided JSP

<?php 
java_import("com.ibm.cics.server.Region");
echo "Your CICS Dynamic Scripting Example (PHP) is now 
running in CICS Region " . Region::getAPPLID() . ".";

?>

38

Notes:

• This is the output from the simple, CICS-supplied PHP application.  

• The PHP sample application is just to verify that PHP is properly installed and configured into your 
CICS.



39

PHP Development:
Make your own PHP project **

** This assumes you have done the one-time workspace setup (already discussed)

40

Notes:

• This section walks you through writing your own PHP application (versus using the CICS-supplied 
example).  

• � This section assumes you have already performed the one-time workspace setup.
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Create OSGi Bundle For the Web Project

This is the start of creating your own PHP Application

Do this for each new PHP application

42

Notes:

• Again, the one-time workspace setup was done on previous slides

• To start creating a PHP application, you first need to create an OSGi Bundle Project.  This OSGi
Bundle Project will contain your PHP code and other web-related artifacts.  To create an OSGi
Bundle project, select Menu bar->New->Other. Then from the Select a wizard dialog, select OSGi-
>OSGi Bundle Project.  

• Then fill in your project name, and check the box next to Add Web support, and change the drop-
down menu to Web 3.0.

• On the Web Module page (of the New OSGi Bundle Project dialog), fill in your desired context root, 
and check the box next to Generate web.xml deployment file.

• From the OSGi Bundle page (of the New OSGi Bundle Project dialog), remove the .qualifier from the 
Version number, and check the box next to Generate an activator.

• Then click the Finish button.
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Add the CICS PHP package to your web 
project’s MANIFEST.MF

You must include thisAdd dependencies on other 
packages, required or imported

44

Notes:

• In your OSGi bundle project, in the WebContent directory, double-click on the MANIFEST.MF file 
(this is the OSGi manifest file). 

• This web project needs to import a PHP Jar file provided by CICS.  Plus any OSGi bundles that this 
OSGi bundle relies on.

• On the tab at the top, not the asterisk between the icon and the name of the file.  This indicates that 
the manifest is ‘dirty’ and needs to be saved.
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Change the Activator class

• package com.ddw.sample.web;

import org.osgi.framework.BundleActivator;
import org.osgi.framework.BundleContext;
import com.ibm.cics.php.CICSPHPInitialiser;

public class Activator implements BundleActivator {

public void start(BundleContext context) throws Exception {
CICSPHPInitialiser.getInstance().activate(context);

}

public void stop(BundleContext context) throws Exception {
}

}

CICSPHPInitialiser is 
provided in the 

com.ibm.cics.php package

46

Notes:

• This is the ‘Activator’ class, and is in Activator.java.  This Java class in your project (in our case the 
project name is com.ddw.sample.web), in the src directory, in a package (in our case the package 
name is com.ddw.sample.web).

• You need to add an import statement for com.ibm.cics.php.CICSPHPInitialiser

• And you have to add the following line to the start method

CICSPHPInitialiser.getInstance().activate(context);

• This initializes the PHP context for the bundle.
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Change ‘web.xml’ in the PHP project

<web-app id=“WebApp_ID” version=“3.0”
xmlns=“http://java.sun.com/xml/ns/javaee”
xmlns:xsi=http://www.w3.org/2001/XMLSchema-instance
xmlns.schemaLocation="http://java.sun.com/xml/ns/javaee
http://java.sun.com/xml/ns/javaee/web-app_3_0.xsd">

<display-name>com.ddw.sample.web</display-name>
<welcome-file-list>

<welcome-file>index.php</welcome-file>

<welcome-file>index.html</welcome-file>
<welcome-file>index.htm</welcome-file>
<welcome-file>index.jsp</welcome-file>

</welcome-file-list>

<servlet-mapping>

<servlet-name>PHPServlet</servlet-name>

<url-pattern>*.php</url-pattern>

</servlet-mapping>

<servlet>

<servlet-name>PHPServlet</servlet-name>

<servlet-class>com.ibm.cics.php.PHPServlet</servlet-class>

<multipart-config/>

</servlet>

</web-app>

Map *.php requests to 
PHPservlet, provided by 

CICS Dynamic Scripting 2.0, 
used to handle PHP requests

PHPServlet definition in 
package com.ibm.cics.php

48

Notes:

• Still in the OSGi web project, change the web.xml file.

• The web.xml file is in your OSGi web project->WebContent->WEB-INF->web.xml

• The <welcome-file-list> indicates that, of someone enters the URL and the context root only, the 
environment will automatically present a index.php file if present, else an index.html file, else an 
index.htm file, etc

• The <servlet-mapping> maps all requests for any file that ends in .php to the PHPServlet.  This would 
include the index.php, or any URL (file) that ends in .php.

• The <servlet> tag specifies the full name of the PHPServlet.
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Write the PHP Program in the IDE

• You can use the PDT(PHP development toolkit) in Eclipse,
or any other PHP IDE

Initial page

Contains Activator, and Java

HTML Pages

Graphics

Cascading StyleSheets

Directory I added for organization

PHP Scripts - I keep business logic 

separate from presentation logic

Separate JavaScript files

This page will always be different, 
depending on the contents of your 
PHP application
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Notes:

• After the previous steps, which will be the same for every PHP project, you will write your code.

• In this OSGi bundle…

• The project Activator and any supporting Java code is in your projects src directory.  The warning 
because of the code I used in a Java class.

• Skipping down to the bottom, you see the initial script that will be executed.

• In the WebContent directory is a fund directory, which contains the Cascading StyleSheets, 
Graphics, HTML, JavaScript, and other PHP scripts used in this application.
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Place your PHP web bundle into 
an Application (EBA) bundle  **

** You will always have to make an EBA bundle, or 

include your PHP web bundle in an existing EBA bundle
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Notes:

• Once you have your OSGi bundle to contain your application, and have coded your application, you 
are ready to create an EBA bundle (that will contain your application bundle).

• In this section we will create the EBA bundle (Enterprise Bundle Archive) and place into it, the bundle 
that contains our web application.  You could place your web project into a new or an existing EBA 
bundle.

• In yet another section in this presentation, we will create a CICS bundle and place the EBA bundle 
into it.
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Create an EBA Project

• File->New->Other

• Select ‘OSGi
Application Project’ -
to contain your web 
OSGi project

• You must place your 
web OSGi project 
into an EBA project

• It is the only 
packaging CICS 
Dynamic Scripting 
2.0 supports
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Notes:

• You can add your web project into a new or existing EBA project (Enterprise Bundle Archive).

• To create a new EBA project, start by selecting from the Menu Bar->File->New->Project

• Towards the top of the Select a wizard page of New Project, you can type ‘osgi’ as a filter.

• Select OSGi Application Project, and click the Next button.
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Place your Web project into the EBA project

Include the web project

Project name
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Notes:

• On the OSGi Application Project page of the New OSGi Application Project wizard…

• Type in the project name (we used com.ddw.sample.app), uncheck ‘Add project to working sets’, 
then click the Next button.

• On the ‘Contained OSGi Bundles and Composite Bundles’ page you would check the boxes next to 
your web project that contains your PHP application.  The click the Finish button.
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Change the EBA Bundle Manifest

Your EBA bundle name

Take off the .qualifier

Your OSGi web project 

The manifest editor 

automatically opens 

when you create an 

EBA bundle project
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Notes:

• In your EBA project (we called our com.ddw.sample.app), in the META-INF directory is your projects 
manifest named APPLICATION.MF

• Double-Click the APPLICATION.MF file to open it in an editor

• For the ‘Version’, take off the .qualifier

• Note that you can also add or remove bundle projects from your EBA bundle by using the add and 
remove button on the middle of the page
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Place your EBA bundle into a CICS bundle,
and export to z/OS  **

** You can place your EBA file into an existing CICS bundle
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Notes:

• Next, you will put your EBA bundle into a CICS bundle and export the CICS bundle from your 
workstation to z/OS Unix System Services.

• Note that you could add your EBA bundle to an new or existing CICS bundle.  In this presentation, we 
will create a new CICS bundle and put our EBA bundle into it
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Create a CICS Bundle Project

CICS Bundle Project 

CICS Bundle Name

CICS Bundle Project 

62

Notes:

• To create a CICS bundle, from the menu bar->File->New->Project (or menu bar->File->new->Other), 
and select CICS Resources->CICS Bundle Project

• On the CICS Bundle Project page, type the CICS bundle name, and the version.  Then press Finish.
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From CICS Bundle ���� reference your EBA 

Your EBA bundle name

Take off the .qualifier

Your OSGi web project 

Right-click on CICS Bundle  

and select New����Other

Can rename the ebabundle

file here, click Back instead 

of Finish on prior screen

It would have said 

app.ebabundle
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Notes:

• Now that you have created your CICS bundle….

• Right-click on your CICS bundle. And select New->Other

• Then from the Select a wizard dialog, select ‘Include OSGi Application Project in Bundle’

• From the Include OSGi Application Project in Bundle dialog, select your OSGi application bundle, full 
in the name of the JVM server under which your PHP application will be running

• The wizard take the highest level qualifier from your package name and adds .ebabundle after it.  If 
you want to change this name to contain more information, the easiest way is to press the Back 
button and change the File name to be what you want.  Leave the file extension alone; the name 
should end in .ebabundle.

• Then press the Finish button.

• Note: you could define other resources in the same CICS bundle.
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Export CICS Bundle to z/OS zFS

• Export CICS Bundle 
project to zFS

• Check Clear if you are 
re-sending it to zFS
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Notes:

• All the work has been on your workstation so far, now you want to export your CICS bundle project to 
z/OS

• Right-click your CICS bundle project, and from the context menu, select ‘Export Bundle Project to 
z/OS UNIX File System’

• Specify the z/OS directory into which you want the CICS bundle placed

• Check the ‘Clear existing contents from Bundle directory’ if you if the bundle directory already has 
something in it.
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Summary of development steps…
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Notes:

• This section summarizes the development steps…
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PHP development is done, on to CICS !

1. Setup target runtime in the CICS explorer

2. Create Web application that will contain the PHP

3. Create OSGi application project (EBA) to package PHP 
project

4. Create CICS Bundle project to manage lifecycle of PHP 
application (i.e include the EBA)

5. Deploy the CICS Bundle to z/OS USS

• Configure and start the runtime in CICS if it is the first PHP 
application in your CICS region

• Install the CICS bundle to install your PHP app into CICS

• Covered on the next slides…

Then, in CICS, you can:
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Notes:

• This slide summarizes the steps to develop your PHP program and define the bundles necessary to
deploy your application to z/OS

• It also summarizes the steps we will cover next; deploying your PHP program in CICS.
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Configure a Liberty Server for PHP,
and try your application…
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Notes:

• Your PHP application runs in a Liberty server containing PHP support.  We will cover these items on 
the following pages.

• We will define a Liberty Profile under CICS

• We will add PHP support to the Liberty Profile

• We will deploy your PHP application

• We will test the applicaiton
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Install CICS Resources

• Install CICS Resources (group DFH$PHP)

• Configure and install the JVM Server

• There is a sample DFHPHP JVM profile

• See details on next page

• Optional: Transaction definition CPTN

• Optional: URIMAP definition DFH$PURI

• Start the Liberty profile in a CICS JVM server

• Create a CICS bundle definition that references your 
EBA bundle (that you placed on z/OS USS)

• Install the CICS bundle into your CICS region
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Notes:

• These are the high level steps.  There is more detail on the next slide.
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Configure Liberty to run PHP

• Update JVMProfile

• Update LIBPATH_SUFFIX for php extensions
• LIBPATH_SUFFIX =<phpfp_home>/lib 

• -Dcom.ibm.cics.jvmserver.wlp.autoconfigure=false
• So that CICS won’t overlay the server.xml file

• -Djava.util.Arrays.useLegacyMergeSort=true
• See CICS Information Center

• Update Liberty server.xml

• Add CICS PHP jar into bundle repository

<bundleRepository>

<fileset dir=“<phpfp_home>/repository“
include="com.ibm.cics.php_1.0.0.jar"/>

</bundleRepository>

• Start Liberty Profile in CICS

• � Install the CICS bundle containing your EBA (your PHP application)

���� There is more information in the CICS InfoCenter
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Notes:

• You need to install the DFH$PHP resource group

• Start your Liberty JVM server 
• The JVM profile needs LIBPATH_SUFFIX=/usr/lpp/cicsts/phpfp/lib (wherever you installed the FP)
• -Dcom.ibm.cics.jvmserver.wlp.http.port=xxxxx
• -Djava.util.Arrays.useLegacyMergeSort=true    (for PHP implementation)

• Configure the server.xml file in ../logs/applid/jvmservername/wlp/usr/servers/defaultServer

• You can have CICS make the initial server.xml file by adding 
–Dcom.ibm.cics.jvmserver.wlp.autoconfigure=true to the JVM profile.  After the server.xml file is 
initially made shut down your Liberty profile, change the above parameter to ‘false’, and then modify 
your server.xml file to include the lines (depending on where you stored your Feature Pack):
<bundleRepository>

<fileset dir="/usr/lpp/cicsts/phpfp/repository" include="com.ibm.cics.php_1.0.0.jar"/>
</bundleRepository>

• Done forget to install the CICS bundle definition
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Test your PHP application

• Input URL http://your.url:port/ddwweb

• Note ddwweb is the application “context root”
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Notes:

• This is a test of the application

• For this application, ddwweb is the context root

In Liberty and WAS, the context root is the part of the URL right after the first slash.  This identifies an 
application.
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Overview of PHP in CICS

80

Notes:

• This is a diagram of the overall flow of a PHP application in CICS.
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Note: Character Encoding

• The Liberty profile is running in an ASCII JVM – you want the data in 
EBCDIC when you use the CICS API

(a TSQ was used because it is the simplest API)

(this sample is in the CICS V5.1 InfoCenter)
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Notes:

• Liberty runs in an ASCII JVM

• Anything you want to write to CICS will have to be in code page 037 (or the code page of your 
country).  The com.ibm.cics.jvmserver.local.ccsid contains your code page.
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Debugging your PHP application…
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Notes:

• This section is on debugging your PHP application in CICS.
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Logs and Configuration File

• CICS Job output

• DFHJVMOUT and 
DFHJVMERR – this is 
the JVM stdout and 
stderr

• Liberty Log files

• Configuration file
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Notes:

• The CICS messages in the message log are likely to contain essential information.

• Then per the last slide, there is the stdout and stderr in the log directory referenced by your JVM 
profile.

• There are also Liberty log files as reference on the last slide.
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Logs – an Example

• This indicates that I have no index.php in the PHP project’s 
WebContent directory

• The initial script – so PHP couldn’t find initial page

• This was in the DFJVMERR file and one of the .log files
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Notes:

• This is a very simple error.  It is caused by not having the index.php in the WebContent directory
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CEDX

• A before and after image of every CICS EXEC command
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Notes:

• To get a quick look at your PHP application, you can use CEDX to get a before and after image of 
every EXEC CICS command equivalent.
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PHP Debugger

• Debugger is in PDT 2.1 or higher

• XDebug

• Port

• Accept remote 
session

(this is on the 
workstation side)
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Notes:

• The PHP debugger is in the PDT tools that you can install into your Eclipse environment.

• You need to configure it.

• It will be contacted by your CICS
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Debug - JVMProfile

• Update JVMProfile

-Dp8.debug=idekey=ECLIPSE_DBGP&
remotePort=<port>&remoteHost=<ip_address>
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Notes:

• In CICS, in the JVMProfile, we need to add -Dp8.debug=idekey=ECLIPSE_DBGP&
remotePort=<port>&remoteHost=<ip_address> 

• Specify the remote port and the hostname of the Eclipse PDT debugger your workstation. 

• This will contact the debugger on our workstation, and will trigger a debug view similar to the Java 
debugger. 

• As you step through your program, you can see the source code and variables.
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Migrating CICS Dynamic Scripting V1.0 and V1.1 
applications…
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Notes:

• This section provides a general overview of changing a CICS Dynamic Scripting V1.0 or V1.1 
application to use CICS Dynamic Scripting V2.0.
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Migrating CICS Dynamic Scripting 1.0,1.1 Apps

• Understand OSGi framework

• Repackage the PHP from WebSphere sMash environment

• Copy the PHP files into a directory inside the example WAB 

• Repackage any Java application as OSGi bundle

• Define it as dependency in PHP project.

• You are now running in an ASCII environment

• Need to review CICS commands

• Limitations

• Does not support the WebSphere sMash functions
• ZRM

• CLI

• Ivy

• …

• Supports PHP only, no Groovy
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Notes:

• The architecture of 2.0 is quite different from previous version. 

• Depending on the size of your application, migration may be lengthy.

• The user has to understand OSGi, since the PHP application and its dependencies need be 
packaged as an OSGi bundle. 

• All the ‘Project Zero’ related functions are removed, and a plain PHP environment is provided.   ZRM, 
CLI, Ivy and so on are not supported. 

• Equivalent functions are provided in version 2.0. The user has to review the PHP code to remove the 
dependencies on Project Zero. 

• In CICS Dynamic Scripting V2.0 only supports PHP.  Groovy is not supported.

• The CICS-related commands will have to allow for running in an ASCII environment instead of 
EBCDIC.
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Summary

• What is CICS Dynamic Scripting

• Dynamic Scripting Feature Pack 1.0, 1.1

• Dynamic Scripting Feature Pack 2.0

• What’s new

• How it works

• How to use it

• Debugging

• Migration Session 14913
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